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PREFACIO. 

 La agroindustria azucarera que es la mayor fuente de trabajo en la costa sur de Guatemala, se ha visto 

en la necesidad de implementar ideas innovadoras en sus distintas etapas de producción, con el fin de mejorar 

su productividad, de tal manera que ellos puedan competir a nivel internacional con los demás países 

productores. 

 Tecnología e innovación se unen al momento de la utilización de programas como los sistemas de 

información  geográfica (SIG). En la actualidad CENGICAÑA  lleva 10 años investigando y desarrollándose 

en los SIG teniendo grandes avances en dicho campo con el fin de sacarle provecho a la utilización de estos 

software para implementarlos en distintas etapas de producción del cultivo, así se está iniciando con la 

agricultura de precisión; para el inicio de este tipo de proyecto se debe comenzar con la obtención de mapas 

de rendimiento, pero para obtener estos mapas es necesario contar con las cosechadoras adecuadas para 

obtener estos datos y poder realizar los mapeos. En Guatemala, el ingenio Magdalena es el único que cuenta 

con este tipo de sistemas. CENGICAÑA en  conjunto con UVG Campus Sur han unido conocimientos para 

evaluar tres distintas metodologías para la obtención de estos mapas, que se espera que sea el inicio de un 

proceso de investigación que genere desarrollo tecnológico para la agroindustria azucarera y Guatemala. 

 Para la evaluación de estas tres metodologías fue necesario llevarlas a los campos de producción 

donde se realizaron los primeros ensayos para generar estos mapas. Se llevó a cabo la evaluación de dichas 

metodologías en la finca El Carrizal, que está bajo la administración del Ingenio La Unión S. A.  

 Siendo los encargados de realizar la toma de datos en campo: 

 P.A. Rodolfo Fuentes 

 T.U. Herbert Fabricio González Donis 

 T.U. Edgar José Humberto Martínez Mejía 

 Fue necesario contar con los datos de tonelaje que se obtenían en la báscula de peso del ingenio, que 

gracias al apoyo del departamento de Cosecha del ingenio se lograron obtener estos datos mediante el Sr. 

Carlos Reyes. 

 Se lograron obtener todos los datos que se necesitaban para llevar a cabo el mapeo, mediante el 

software Arc View 10.2 de Arc GIS, que con el apoyo del Ing. Braulio Villatoro se realizaron  los mapas y se 

llevó acabo el  análisis pertinente para consolidar todo un proceso de investigación, y que se espera que sea el 

inicio de una nueva línea investigativa para el desarrollo integral de la agroindustria. 

 Cabe resaltar que este proceso investigativo no hubiera sido posible sin la ayuda de: 

 El Señor nuestro Creador  

 Mi Madre: Magda Violeta Mejía Ramírez de Martínez 

 Mi Padre: Edgar Estuardo Martínez Mejía 
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 Mis Hermanas: Magda Violeta y Aura Lucía Argentina, Martínez Mejía. 

 Mi Familia 

 Mis compañeros de la Universidad “Bandón Agrícola”  

 A Universidad del Valle de Guatemala Campus Sur, catedráticos, alumnos y personal agrícola.    

 A Rodolfo Fuentes, asistente del programa de agronomía de CENGICAÑA. 

 A mi asesor: Ing. Braulio Villatoro 

 A la Coordinación de plagas de Ingenio La Unión S, A. 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

VII 

 

 



 

CONTENIDO 

página 

PREFACIO…………..…………………………………………………….……………………………...……vi 

LISTADO DE FIGURAS………….…………………………………………………………………………viii 

LISTADO DE TABLAS ….…………………...………………………….…………………………………...ix 

SINOPSIS……….. ….…………………………………………………….…………………………………....x 

I. INTRODUCCIÓN……………………………………..…………………………………………….1 

II. OBJETIVOS………………………..………………………………………………………………..2 

2.1. General……………………………………………………………………………………………….2 

2.2. Específicos…………………………………………………………………………………………...2 

III. JUSTIFICACIÓN………………...………………………………………………………………….3 

IV. MARCO TEÓRICO…………..……………………………………………………………………..4 

4.1. Agricultura de precisión……………………………………………………………………………..4 

4.2. Agricultura de precisión en cultivos tradicionales…………………………………………....……..5 

4.3. Mapas de rendimiento…………………………………………………………………………….....5 

4.4. Sistema de posicionamiento global……………………………………………………………….....5 

4.4.1. ¿Cómo funciona el GPS?.....................................................................................................................6 

4.4.2. Usos para el GPS.................................................................................................................................6 

4.5. Sistema de cosecha manual de caña de azúcar………………………………………………………6 

4.5.1. Cosecha manual……………………………………………………………………………………...6 

4.6. Caña de azúcar (Saccharum officinarum)…………………………………………………………….….....7 

4.6.1. Procesos de medición de producción…………………………………………………………….…..7 

V. MARCO METODOLÓGICO.………………………………………………………………………8 

5.1. Evaluación de tres distintas metodologías para realizar mapas de rendimiento  

 en caña de azúcar  en el sistema de cosecha manual y alce 

mecanizado………………………………………………………………………...………………...8 

5.1.1. Lugar de evaluación………………………………………………………………………………....8 

5.1.2. Materiales……………………………………………………………………………………………9 

5.1.3. Fase de campo…………………………………………………………………………………….....9 

5.2. Metodologías a evaluar…………………………………………………………………..…10 

5.2.1. Metodología de 1  punto por cada acción de colecta de la  alzadora (uñada)……...……….10 

5.2.2. Metodología de punto donde estuvo un cortador dentro de la chorra………………………11 

5.2.3. Metodología de 1 punto al inicio y 1 punto al final de donde se llena la jaula………….….12 

5.3. Fase de gabinete…………………………………………………………………………….13 

5.3.1. Metodología para la elaboración de mapas de  

  rendimiento mediante el software  

  ArcGISv.10.2…………………………………………………………………………….....13 

5.3.1.1. Descarga de punto del GPS…………………………………………………………………13 

5.3.1.2. Generación de mapas de interpolación……………………………………………………..15  

5.3.1.3. Estimación de TCH…………………………………………………………………………17 

5.3.1.4. Generación de interpolaciones para obtención de mapas de  

  rendimiento en  cosecha manual al momento    del  

  al mecanizado…………………………..…………………………………………………...17 

VI. RESULTADOS………………………………………………………………………………….21 

VII. ANÁLISIS DE RESULTADOS……...………………………………………………………....26 



VIII. CONCLUSIONES………...…………………………………………………………………….28 

IX. RECOMENDACIONES………………………………………………………………………...30 

X. BIBLIOGRAFÍA………...……………………………………………………....……...............31 

XI. ANEXOS………………………………………………………………………………………..32 

XII. GLOSARIO……….…………………………………………………………………………….33 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

 

 

 

 

LISTA DE FIGURAS. 

Página   

Figura 1: Ciclo de la agricultura de precisión……………………………………………………………….04 

Figura 2: Fincas de producción de ingenio La Unión S.A………………………………………….……….08 

Figura 3: Mapa de rendimiento de la  metodología de 1 punto por cada uñazo de alzadora……………….22 

Figura  4: Mapa de rendimiento de la metodología de 1 punto donde estuvo un cortador dentro 

de la chorra………………………………………………………………………………………………….23 

Figura 5: Mapa de rendimiento de la metodología de 1 punto al inicio y  1 punto al final  

de donde se llena la jaula……………………………………………………………………………………24 

 

 

 

 

 

 

VIII 

 



 
 

 

 

 

 

LISTADO DE TABLAS. 

Página   

Tabla 1: Categoría de colores de mapas de rendimiento……………………………………………………19 

Tabla 2: Categoría de TCH de los mapas de rendimiento…………………………………………………..19 

Tabla 3: Estimación de TCH de mapas de rendimiento…………………………………………..…….…..21 

 

 

 

 

 

 

 

 

 

IX 

 



 
 

SINOPSIS. 

 Se realizó la evaluación de  tres distintas metodologías, para realizar mapas de rendimiento en 

caña de azúcar, dichas metodologías fueron: 

o Metodología de 1 punto por cada acción de colecta de la  alzadora (uñada). 

o Metodología de 1 punto donde estuvo un cortador dentro de la chorra.  

o Metodología de 1 punto al inicio y 1 punto al final de donde se llena la jaula. 

 Con el propósito de obtener mapas de rendimiento expresado en toneladas métricas de caña por 

hectárea (TCH) en el cultivo de caña de azúcar, se realizó el presente estudio, el objetivo es tener una 

herramienta de bajo costo para la elaboración de mapas de  rendimiento, en campos cultivados con caña de 

azúcar. El mapa de rendimiento es la base fundamental para el inicio de proyectos de agricultura de 

precisión, los mapas de rendimiento, son imágenes geo-referenciadas con una escala de colores, que 

indican el rendimiento del cultivo en un punto en específico, estos mapas generan información base, para la 

toma de decisiones en el proceso de la aplicación de dosis de los diferentes agroquímicos (fertilizantes, 

madurantes, herbicidas, fungicidas, etc.), así también, como la aplicación de riego (frecuencia e intensidad), 

que necesita el cultivo. El presente estudio se realizó evaluando sistemas de corte manual, al momento del 

alce mecanizado; utilizando el Sistema de Posicionamiento Global (GPS por sus siglas en inglés); mediante  

la toma de puntos en distintas fases en el proceso de alce de la caña de azúcar en los campos de producción 

(lote de alce). Los puntos obtenidos se  correlacionaron  con el peso obtenido por jaula de caña de azúcar, 

desde el campo de producción hasta la báscula de peso, en el patio de caña; este trabajo permitirá obtener 

en diferentes niveles de detalle la productividad de los campos del cultivo de la caña de azúcar; generando 

mapas de rendimiento para el análisis. 

X 



 
 

 

I. INTRODUCCIÓN. 

 La agroindustria azucarera de Guatemala ha iniciado la  implementación de proyectos de 

agricultura de precisión, lo cual hará mejorar la eficiencia del uso y aplicación de agroquímicos, así como 

también de procesos agrícola.  El ciclo de la agricultura de precisión inicia con la obtención de mapas de 

rendimiento, a través de los cuales es posible determinar la variabilidad que existe de un campo de 

producción a otro, y posteriormente se realiza el análisis de las causas de variabilidad, las cuales pueden 

ser: diferencias de características de suelo, diferencias en el manejo agronómico del cultivo, problemas de 

plagas, enfermedades o malezas, deficiencias de fertilización, mal uso de aplicación de agroquímicos, riego 

ineficiente, variedad de especies a producir. Se utilizaron distintas tecnologías de agricultura de precisión: 

sistema de posicionamiento global, sistemas de información geográfica, para medir la productividad de los 

campos agrícolas. 

 Se desconoce con precisión cuál es la producción por unidad de área; lo que incide en calcular 

aproximaciones, de los niveles de producción de toneladas métricas de caña por hectárea (TCH), y por ende 

se desconoce la eficiencia de producción actual. 

 En la zona cañera de la costa sur de Guatemala, no se cuenta con metodologías que permitan 

obtener mapas de productividad con los sistemas de cosecha manual utilizados actualmente por la 

agroindustria azucarera. 
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II. OBJETIVOS. 

2.1. GENERAL 

Evaluar tres metodologías para realizar mapas de rendimiento en caña de azúcar en el sistema de 

cosecha manual y alce mecanizado. 

2.2. ESPECÍFICOS  

o Generar los mapas de rendimiento de los lotes evaluados utilizando sistemas de información 

geográfica. 

o Determinar la metodología más confiable, con base al análisis visual realizado. 

o Comparar los mapas de rendimiento de caña de azúcar obtenidos con las metodologías evaluadas: 

• Metodología de 1 punto por cada uñazo de alzadora 

• Metodología de 1 punto donde estuvo un cortador dentro de la chorra. 

• Metodología de 1 punto al inicio y  1 punto al final de donde se llena la jaula. 
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III. JUSTIFICACIÓN. 

 Para implementar proyectos de agricultura de precisión en campos de producción agrícola; es 

necesario conocer la variabilidad espacial y temporal que existe en los campos. En el caso de caña de 

azúcar, actualmente se obtiene el dato de producción en el  nivel de lote, en base a la medida en báscula de 

toneladas de caña cosechadas en un lote y el dato se divide entre el área del lote, para obtener el dato en 

toneladas de caña por hectárea (TCH). 

 Con esta investigación se estará aportando conocimiento de la mejor  metodología de las tres 

evaluadas para obtener mapas de rendimiento en caña de azúcar. 

 Un lote de producción tiene un tamaño promedio de 10 hectáreas, en la zona cañera de la costa sur 

de Guatemala.  

 En el transporte de la caña de los campos de producción hacia los ingenios azucareros se utilizan 

jaulas de distintas dimensiones y en distinto número (dobles, triples, tetras, hexas, heptas) dependiendo de 

la distancia y si la caña es trasportada por rutas internas o por carreteras nacionales. Las jaulas son jaladas 

por un tráiler. En el desarrollo de este trabajo se midió el peso de todas las jaulas ingresadas a la báscula del 

ingenio del lote donde se realizó la evaluación de las metodologías. 

 

 

 

 

 

 

3 



 
 

 

IV. MARCO TEÓRICO. 

4.1. Agricultura de precisión. 

 Ruiz (2011, 02)  señala que: “Se refiere al conjunto de técnicas orientado a optimizar el uso de los 

insumos agrícolas en función de la variabilidad espacial y temporal de la producción agrícola”  

 Variabilidad espacial: expresa las diferencias de producción dentro de un mismo lote, en un mismo 

ciclo de cultivo. 

 Variabilidad temporal: formula los cambios de producción de un mismo lote, en distintos ciclos de 

cultivo. 

 Ruiz (2011, 03) señala que: “No es simplemente la habilidad de aplicar tratamientos distintos a 

escala local de parcelas, sino que debe ser considerada como la habilidad para controlar con precisión las 

labores de una empresa agrícola a un nivel local y de finca, así como tener los conocimientos suficientes 

para entender todos los procesos relacionados, de modo que puedan aplicarse los resultados obtenidos para 

obtener una meta determinada” 

 Ruiz (2011,06) señala que: “Historia: se inicia en los años 70, cuando el Departamento de Defensa 

de Estados Unidos comenzó a colocar los Satélites de Posicionamiento Global (GPS); para ayudar a las 

piezas de artillería a apuntar a sus blancos y para ayudar a los submarinos a localizar suposición” 

 Según, José Rodolfo Ruiz (2011, 06), mediante la aplicación del GPS + sistemas de control 

mecánico, electro-hidráulico y sensores, ayuda a la agricultura a que se realicen  labores agrícolas de forma 

precisa y controlada, por medio de la telemetría se puede realizar labores como: la fumigación sin 

marcadores, localización de obstáculos, etc. 

Figura 1. Ciclo de la agricultura de precisión 

 

Fuente: (Slideshare.net). 08 de 07 de 2015, 11:00 a.m. 
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4.2. Agricultura de precisión en cultivos tradicionales.                                   5 

 Los sistemas tradicionales de producción tratan las propiedades agrícolas de forma homogénea 

tomando como base condiciones promedio de las extensas áreas de producción para implementar las 

acciones correctivas de los factores limitantes. Con el fin de obtener unos sistemas de producción más 

competitivos y aumentar la eficiencia agronómica del sector productivo, se incorporan nuevas técnicas para 

incrementar y/o mantener la productividad de los cultivos, buscando, al mismo tiempo, reducir los costos 

de producción. 

 PROCISUR (2003, 20) señala que: “el resultado de la cosecha de dos lotes con soja y maíz que 

suman 265 hectáreas, en la región del Plan Alto Médio “Gaúcho”, en Río Grande del Sur, Brasil, confirman 

el aumento de productividad y la reducción de costos prometida por la agricultura de precisión. En el lote 

de 132 hectáreas cultivando maíz, el rendimiento alcanzó 5.880 kg/ha. El resultado es 20 por ciento 

superior al promedio regional, 4.680 kg/ha. El número también es 13 por ciento superior al promedio de 

5.100 kg/ha obtenido en otros cultivos de la misma propiedad, la Hacienda Anna, donde se aplicaron los 

métodos convencionales. En el área cultivada con maíz, se alcanzó un ahorro de 18 por ciento en la 

aplicación de fertilizante”.   

4.3. Mapas de rendimiento. 

 El mapa de rendimiento produce información detallada de la producción del campo y concede 

parámetros para realizar diagnósticos y corregir las causas de bajos rendimiento en un área de campo más 

específica, con el fin de estudiar porque motivo el rendimiento es más alto en algunas zonas, y dichos 

registros pueden establecer los siguientes parámetros: 

 Área (Ha, Mz, etc.) 

 Variedades (especie en producción) 

 Tiempos (Fecha de producción del cultivo) 

 La Universidad de Palermo, señala que: (19:55 hrs. 05 de 04 de 2015) “Un monitor de rendimiento 

es un sistema que recoge la información procedente de distintos sensores y gracias a un software calcula el 

rendimiento de un cultivo en el tiempo y en el espacio, basándose en la información de localización de cada 

parcela proporcionada por el sistema de localización satelital GPS. El resultado se representa en un mapa 

gráfico” 

 IDESIA (2011, 63) señala que: “Los Mapas de Rendimiento (MR) son imágenes geo-referenciadas 

con una escala de colores que indican el rendimiento de un punto en específico. Por lo general, son 

desarrollados por científicos y especialistas de la Agricultura, donde los interesados (agricultores, 

cosechadores y productores) deben pagar un precio alto para obtenerlos. Los MR son entradas para el 

proceso de aplicación de Dosis Variable (DV) de los distintos productos que necesita un cultivo 

(fertilizantes, herbicidas, riegos, etc.). Las cosechadoras, fertilizadoras, y otras maquinarias, necesitan de la 

instalación de un computador de abordo para el control y monitoreo, también es válido el uso de sensores 

de flujos para medir y registrar el rendimiento puntual”. 

4.4. Sistema de posicionamiento global. 

 Según, Quevedo (2012, 02): “El Sistema de Posicionamiento Global (GPS por sus siglas en inglés 

"Global Positioning System") es un sistema de navegación compuesto de una flotilla de satélites puestos en 

órbita por el Departamento de Defensa de los Estados Unidos, y sus estaciones en tierra firme.                   
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Usando  GPS, uno puede determinar automáticamente su posición (latitud y longitud) en la Tierra. 

Funciona continuamente en todas partes del mundo y es disponible a todos libre de cargos. Con orígenes en 

aplicaciones militares secretas, GPS se ha convertido en parte de nuestra vida cotidiana” 

 4.4.1. ¿Cómo funciona el GPS? Según, University of Florida (21:30 hrs. 07 de 08 de 2015) 

que cita: “ El GPS depende en que cada satélite en la constelación transmita su posición exacta y una señal 

de tiempo extremadamente precisa a los recibidores en la tierra. Dada esta información, los receptores GPS 

pueden calcular su distancia al satélite, y combinando esta información de cuatro satélites, el recibidor 

puede calcular su posición exacta usando un proceso llamado trilateración”. 

 4.4.2. Usos para el GPS. El desarrollo de posicionadores de GPS precisos y a precios 

razonables, y la miniaturización de componentes electrónicos, han hecho que el GPS se encuentre 

disponible a casi todo el mundo, lo cual ha facilitado que el GPS esté convirtiéndose en una necesidad en 

muchas facetas de la vida cotidiana. 

 Según, Gina Catalina Quevedo, (2012,02) Agricultura: La navegación por satélite es una 

herramienta que puede ayudar a los agricultores a aumentar su producción y a mejorar la eficiencia en el 

manejo agronómico del cultivo. Sistemas de GPS ubicados en los tractores y en otros vehículos agrícolas, 

junto con sofisticados sistemas de información geográficos utilizan varios métodos para recoger datos sobre 

las condiciones del suelo, humedad, temperatura y muchas otras variables. Con esta información, el sistema 

puede controlar muchos aspectos de la operación agrícola, por ejemplo, la intensidad de siembra por 

terreno, la aplicación de fertilizantes e insecticidas, los patrones de riego y mucho más. Estos sistemas 

también pueden ayudar a los agricultores a mantenerse al tanto de la operación de sus fincas, manteniendo 

registros de rendimiento, historia de aplicación de productos químicos, análisis del suelo, registros de 

pérdidas y ganancias por terreno, y muchos otros. Aplicaciones modernas de la tecnología GPS también 

incluyen el posicionamiento y la operación de equipos de agricultura robóticos en el campo. 

4.5. Sistema de cosecha manual de caña de azúcar. 

 En los ingenios azucareros hay un departamento que se encarga de realizar la coordinación de 

dicha labor. Regularmente por zafra (periodo de cosecha del cultivo de caña de  azúcar), se contrata 

personal para que realicen dicha labor. Según AZASGUA (2016), se generan 350,000 empleos directos e 

indirectos, de estos 35,000 empleos corresponden a cortadores de caña.  

 4.5.1 Cosecha manual. El éxito de un programa de corte manual de caña depende de la 

programación y coordinación anual de actividades que deben ajustarse cada mes de acuerdo con el estado 

de maduración del cultivo, la variedad, la eficiencia, disponibilidad de mano de obra y maquinaria. 

 El frente de corte (órgano encargado del corte de caña al momento de cosecha) está conformado 

por las siguientes personas. 

1. Brechero: determina el área de corte de cada operario de corte. 

2. Operador de corte: persona que corta la caña. 

3. Monitor: persona encargada de verificar que el operador de corte realice de manera correcta y 

eficiente el corte. 

4. Cabo-corte: encargado de la asistencia y disciplina del frente de corte. 

5. Auxiliar de corte: encargado de vigilar varios frentes en esta actividad. 
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 Frente de alce está conformado por las siguientes personas. 

1. Operador de alzadora: maneja la alzadora, para la recolección de las choras de caña postradas, y 

las carga a una jaula, tirada por un tractor. 

2. Operador de tractor: maneja el tractor, tirando una jaula, paralelamente con la alzadora, para 

facilitar el alce de la jaula. 

3. Apuntador: encardado de anotar en  la computadora de mano “handheld” los datos de los 

cortadores que se encargaron de realizar la chora, así como también los datos de tractor, alzadora. 

4. “Zanatero”: operario que se encarga de juntar las cañas que la alzadora no puede recoger o que 

deja tiradas al momento del llenado de la jaula. 

5. Enganchadores: personas que se encargan de enganchar y desenganchar las jaulas del tractor, para 

luego colocarle fajas y engancharlas al camión que las transportará hacia la fábrica. 

6. Encargado de envío: persona que toma los datos de entrada de la jaulas vacías y llenas de los 

camiones que llegan al frente, así como de entregar los reporte que el apuntador le entrega, y 

enviarlos en los camiones a la fábrica, donde cuantifican el peso y que remuneración deben de 

devengar todos los miembros del frente de cosecha.  

7. Encargado de alce: persona que supervisa o todas las personas del frente de alce. 

                                                                                                                                   

4.6. Caña de azúcar (Saccharum officinarum). 

 Según la Asociación Naturland. (2000, 05): “La caña de azúcar (Saccharum officinarum) tiene su 

origen genético en Nueva Guinea. La planta pertenece a la familia Poaceae. La caña es una planta C-4 con 

alta eficiencia fotosintética. Es un cultivo duradero y muy auto compatible. Según variedad y condiciones 

locales, la planta forma entre 4 y 12 tallos que pueden crecer entre 3-5 m de altura. El contenido de azúcar 

(sacarosa) oscila entre 11 y 16%” 

 4.6.1. Procesos de medición de producción. La forma de medir la producción  en el 

cultivo de caña de azúcar que va a ser procesada  en la fábrica de azúcar (ingenio azucarero) es mediante el 

peso que registran las jaulas que transportan la caña de azúcar desde el campo hasta la entrada de la fábrica; 

el peso se registra en toneladas cortadas por número de lote. Al inicio del proceso industria todavía en el 

patio de caña se realiza una muestra la cual se procesa en el laboratorio, donde se obtiene el rendimiento de 

sacarosa que contiene la caña que es recolectada de las fincas; Al final del proceso se reporta la producción 

con las siguientes variables: 

 Toneladas de caña por hectárea (TCH) 

 Toneladas de azúcar por hectárea (TAH) 

 Grados brix de la caña (sólidos solubles presentes en una solución) 

 

 

 

 



 
 

V. MARCO METODOLÓGICO. 

5.1.  Evaluación de tres distintas metodologías para realizar mapas de rendimiento en 

caña de azúcar en el sistema de cosecha manual y alce mecanizado. 

o Metodología de 1 punto por cada acción de colecta de la  alzadora (uñada). 

o Metodología de 1 punto donde estuvo un cortador dentro de la chorra.  

o Metodología de 1 punto al inicio y 1 punto al final de donde se llena la jaula. 

                                                                                                                                                                         

 5.1.1. Lugar de evaluación: 

Figura 2. Campos de producción de ingenio La Unión 

Fuente: CENGICAÑA, 2016. 

Se realizó mediante tres fases: 

• Fase de campo, se obtuvieron  los datos en campo a través de la geo referenciación de los puntos 

con los dispositivos   GPS, en el área de cosecha de un lote de producción comercial del cultivo de 

caña de azúcar, no tomando en cuenta variedad, altitud, número de cortes, etc.  

• Fase de gabinete, se  recopilaron  y tabularón de la información generada, para la elaboración de 

los mapas de rendimiento, dicha información fue recabada en el periodo de la zafra 2015-2016. 

8 



 
 

9 

• Discusión de los resultados, con el fin de establecer la metodología más confiable al momento de 

la elaboración de mapas de rendimiento.   

 5.1.2. Materiales:  

 Navegador de sistema GPS 

 Computadora 

 Software ArcGIS 

 Mapas de fincas 

 Libreta de apuntes 

 Cámara fotográfica 

 Tractores 

 Alzadora 

 Jaula cañera 

 Personal del frente de alce manual 

 5.1.3. Fase de campo: 

 Establecer el área a evaluar. 

 Ubicar el lote o pante donde se realizará la prueba. (No se tomó en cuenta la finca, fecha de corte 

entre otros factores, siempre y cuando el lote a evaluar haya tenido el manejo agronómico de 

producción comercial).  En esta investigación lo importante es validar la metodología de 

elaboración de mapas de rendimiento, por eso los factores mencionados no se consideran. El único 

requisito que debe tener el lote es que sea corte manual con alce mecanizado y haber sido 

manejado agronómicamente como un lote comercial. 

 Se espera que termine el corte de la caña dentro del lote seleccionado, siempre y cuando el frente 

de alce no haya iniciado su labor. 

 Al iniciar el alce dependiendo de la metodología a evaluar se procede a georeferenciar el punto de 

interés. 
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5.2. Metodologías a evaluadas:  

 5.2.1. Metodología de 1  punto por cada acción de colecta de la  alzadora 

(uñada). Esta  metodología se basa en la obtención de un punto en cada lugar donde la alzadora realiza la 

labor de levantar la caña ya cortada y la deposita en las jaulas en las cuales será trasladada al ingenio. Se 

obtiene geo referenciados con el receptor de GPS, con la opción  “mark waypoint”,  que corresponderá a 

ser el mismo número que las uñadas totales que se necesitó para que la jaula a ser evaluada sea llenada por 

completa. 

 Para poder replicarlo se debe realizar de la siguiente manera: 
 

• Identificación y ubicación del lote  que será alzado y trasladado a la fábrica, para su 

industrialización. 

• Establecer el punto geo referenciado con el dispositivo  GPS, con la opción  “mark waypoint”  en 

el punto de partida del alce de la caña, dejando una distancia pertinente entre la alzadora y el lugar 

donde se establecerá el punto de referencia,  para proceder a realizar la evaluación. 

• Anotar en la libreta de campo el nombre de la metodología a ser evaluada, el número correlativo 

de  la opción  “mark waypoint”  que aparece en el GPS para delimitar el punto de inicio de la base 

de datos de la jaula a ser evaluada. 

• Establecer un punto geo referenciado con el dispositivo  GPS en cada lugar que la alzadora realice 

la labor de alce en la chorra, con la opción  “mark waypoint”  hasta que finalice de llenar la jaula 

evaluada. (Dejando una distancia pertinente entre la alzadora y el lugar donde se establecerá el 

punto de referencia). Se tiene que esperar a que la alzadora realice la acción de la cosecha de la 

caña cortada, de tal manera que se establezca en el lugar preciso el punto geo referenciado, ya que 

no se puede tomar el “waypoint” hasta que se realice dicha labor. 

• Anotar en la libreta, el correlativo del GPS en cada punto de” mark waypoint” donde se realice la 

labor de alce en la chorra. 

• Anotar en la libreta de campo, el número correlativo que aparece en el GPS, de la función de” 

mark waypoint” para delimitar el punto final de la base de datos de cada jaula del lote a ser 

evaluado. 
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• Solicitar al apuntador que opera la handheld, la nota de envío de la jaula, donde se encontrará el 

código de la jaula, número de uñadas de la alzadora, lote, fecha, frente y hora de alce, con el cual 

se solicitara el peso en báscula, que obtuvo la jaula que se evaluó.  

 

5.2.2.  Metodología de 1 punto donde estuvo un cortador dentro de la chorra. En 

ésta metodología, se obtienen puntos georeferenciados en el punto de inicio de la parcela cortada 

por cada uno de los cortadores. Se reducen los puntos geo-referenciados, pero se aumenta la 

distancia entre punto que se geo-referencia mediante la opción  de “mark waypoint”, en 

comparación con la metodología de cada uñada. La metodología utiliza los pasos siguientes: 

 Identificación y ubicación del inicio del lote, que será alzado y trasladado a la fábrica, para su 

industrialización. 

 Establecer el punto geo-referenciado con el dispositivo  GPS, con la opción  “mark waypoint”  en 

el punto de partida del alce de la caña, dejando una distancia pertinente entre la alzadora y el lugar 

donde se establecerá el punto de referencia,  para proceder a realizar la evaluación. 

 Anotar en la libreta de campo el nombre de la metodología a ser evaluada, el número correlativo 

de  la opción  “mark waypoint”  que aparece en el GPS para delimitar el punto de inicio de la base 

de datos de la jaula a ser evaluada. 

 Establecer un punto con la opción  “mark waypoint”  que aparece en el GPS para delimitar donde 

empezó la sección de la chorra que el cortador realizó, de la cual la caña cortada será depositada 

en la misma jaula; se ha de tomar en cuenta solo el número de cortadores que fue requerido para 

llenar la jaula, y ser mandada a báscula, (Dejando una distancia pertinente entre la alzadora y el 

lugar donde se establecerá el punto de referencia). 

 Anotar en la libreta, el correlativo del GPS en cada punto de” mark waypoint” donde se realice la 

labor de alce en la chorra, de cada cortador. 
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 Anotar en la libreta de campo, el número correlativo que aparece en el GPS, de la función de” 

mark waypoint” para delimitar el punto final de cada sección que realizo cada cortador, solo tomar 

en cuenta la cantidad de cortadores que se necesitó para llenar  cada jaula del lote a ser evaluado. 

 Solicitar al apuntador que opera la handheld, la nota de envío de la jaula, donde se encontrará el 

código de la jaula, número de uñadas de la alzadora, lote, fecha, frente y hora de alce, con el cual 

se solicitara el peso en báscula, que obtuvo la jaula que se evaluó. 

 

 5.2.3. Metodología de 1 punto al inicio y 1 punto al final de donde se llena la 

jaula. Con la metodología de obtención de un punto geo referenciado con el dispositivo  GPS, se marca un 

punto con la opción  “mark waypoint” donde inicio a llenar la jaula y otro al finalizar el llenado de la 

misma,  En esta metodología, se aumenta la distancia entre puntos obtenidos. La metodología se realiza de 

la siguiente manera: 

 Identificación y ubicación del inicio del lote, que será alzado y trasladado a la fábrica. 

 Establecer el punto geo-referenciado con el dispositivo  GPS, con la opción  “mark waypoint”  en 

el punto de partida del alce de la caña, dejando una distancia pertinente entre la alzadora y el lugar 

donde se establecerá el punto de referencia,  para proceder a realizar la evaluación. 

 Anotar en la libreta de campo el nombre de la metodología a ser evaluada, el número correlativo 

de  la opción  “mark waypoint”  que aparece en el GPS para delimitar el punto de inicio de la base 

de datos de la jaula a ser evaluada.  

 Establecer 1 punto geo-referenciado con el dispositivo  GPS, con la opción  “mark waypoint”   de 

inicio del alce de la chorra y el punto de final del alce de la chorra. (Dejando una distancia 

pertinente entre la alzadora y el lugar donde se establecerá el punto de referencia). 

 Anotar en la libreta de campo, el número correlativo que aparece en el dispositivo GPS con la 

opción” mark waypoint”   para delimitar el punto inicio y el punto final de la base de datos de 

cada jaula del lote a ser evaluado. 
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 Solicitar al apuntador que opera la handheld, la nota de envío de la jaula, donde se encontrará el 

código de la jaula, número de uñadas de la alzadora, lote, fecha, frente y hora de alce, con el cual 

se solicitara el peso  en báscula, expresado en toneladas métricas de caña por hectárea, que obtuvo 

la jaula que se evaluó.  

5.3. Fase de gabinete. 

En esta fase de procedió a la  elaboración de los mapas de rendimiento obtenido con cada metodología 

evaluada. El análisis geográfico se realizó con el software ArcMap de ArcGIS v. 10.2  para hacer las 

comparaciones visuales entre las metodologías evaluadas.  

La generación de los mapas se desarrolló en cuatro etapas: 

 5.3.1. Metodología para la elaboración de mapas de rendimiento mediante el 

software ArcGIS v. 10.2. 

  5.3.1.1. Descarga de puntos del GPS. 

• Se abre el programa MapSource  

• Se abre lo ventana archivo > abrir, seleccionar el archivo .gpx que se encuentra en la memoria del 

GPS; y se abre el archivo. 

• Utilizando Microsoft Excel, se trabaja la base de datos que tiene los siguientes campos: 

Número (No.): es el número de waypoint con el cual registra el navegador GPS cada una de las 

localidades. 

Altitud: altura en metros sobre el nivel del mar de la localidad. 

Fecha: fecha y hora en la cual se generó la lectura. 

X_UTM: La coordenada en “X” (longitud) de cada punto. 
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Y_UTM: La coordenada en “Y” (latitud) de cada punto. 

Peso: el peso registrado por la jaula en la báscula. 

Uñadas: número de veces que la alzadora, realiza labor del alce de caña.     

Metodología: Que tipo de metodología se está empleando (Punto uñada, punto cortado, punto inicio-

final.) 

Peso uña: es la relación entre el peso registrado por la jaula en la báscula y el número de uñadas que se 

utilizaron al momento de llenar la jaula. 

• La tabla generada en el programa Excel, no debe de contener formulas, bordes, texto con negrita. 

• Se abre la ventana de ArcMap> Add Data> seleccionar la carpeta donde se encuentra el archivo de 

Excel> Add. 

• Convertir el archivo Excel a un shapefile (SHP). 

Clic derecho sobre el archivo de Excel cargado> Display XY Data>  

• Ubicación de campos. 

En la ventana de X Field: se coloca la coordenada en X_UTM, en la ventana de Y Field: se coloca la 

coordenada en Y_UTM > Edit. 

• La ventana Spatial Refencence Properties> select. 

• Ventana donde se tiene la plantilla del sistema de coordenada que será utilizado> WGS 1984 UTM 

Zona 15N.prj> Add>Aplicar>Aceptar>OK>Aceptar. 

• Sobre la hoja eventual que genero el proceso de la proyección de las coordenadas ingresadas al 

software> Click derecho> Data> Export Data>Browse>Colocar el nombre al archivo que se va a 

generar>Save>OK>Si/No. 
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  5.3.1.2. Generación de mapas interpolados. Según, ESRI, 11:31 a.m. 31 del 01 de 

2016: La interpolación es una herramienta integrada en el software ArcGIS que sirve para  predecir valores 

para las celdas de un ráster a partir de una cantidad limitada  de puntos de datos de muestra. Puede 

utilizarse para predecir valores desconocidos de cualquier dato de un punto geográfico. 

• Abrir la ventana del software ArcMap>Add Data.  

• Cargar el shapefile de puntos que fueron geo referenciados y el shapefile de los polígonos de los 

lotes evaluados. 

• Abrir el software ArcGIS 10.2> Add Data> seleccionar shapefile_de lotes y puntos geo 

referenciados> Add. 

• Se realiza una interpolación en el software ArcGIS para obtener el mapa de rendimiento. 

En el software ArcGIS abrir la ventana de herramientas ArcToolbox> Spatil Analyst Tools> 

Interpolation “doble Click” > IDW “Seleccionar”. 

En la ventana de la herramienta IDW> Input point features “seleccionar el shapefile de puntos geo 

referenciados”. 

Z Value field “La variable que será interpolada”> Peso_uña. 

Output raster “seleccionar la ubicación de donde se guardara el archivo y se coloca el nombre> Save 

>Environment Settings> Processing Extent> seleccionar el_shapefile_de polígonos de los lotes a ser 

analizados>Raster Analysis> Mask “seleccinar el shapefile de polígonos> OK>OK. 

• Generación de rango de análisis de la información. 

Sobre la capa de la interpolación IDW generada de la variable Peso_uña “Doble click izquierdo”> 

Layer Properties> Symbology> Classified> Seleccionar el número de clases a utilizar> Classify>  
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Break Values “se asigna los valores que serán analizados> OK> Color Ramp “Seleccionar los colores a 

utilizar”> Aplicar> Aceptar. 

• Exportar el mapa generado. 

En la ventana de ArcMap ubicarse en la pestaña File>Page and Print Setup>Size “Carta”> Orientation 

“Landscape”> Check en “Show Printer Margins on Layout> OK> Layout View . 

Clic derecho sobre el la capa de interpolación generada, “Zoom to layer” 

• Edición del mapa. 

Seleccionar la vista previa del mapa> Insert> Title “Nombre del título del mapa” 

Insert> Legend “campos a ver en la leyenda>Siguente> Titulo de la 

leyenda>Siguiente>Siguiente>Siguiente>Finalizar. 

Insert> Norh Arrow Selector “seleccionar el dibujo que se desea colocar”>OK. 

• Exportar en archivo de imagen el mapa generado. 

Se abre la ventana File de ArcMap> Export Map> Nombre “Nombre del archivo” > Tipo “Tipo de 

archivo que se generará (JPG, PDF, etc.)>Guardar 

• Interpolación de Kriging . 

 Abrir la ventana de ArcMap> ArcToolbox >Spatial Analyst Tools> Interpolation> Kriging “Doble 

click izquierdo” 

 Input point features “seleccionar el shapefile de puntos geo referenciados” > z Value field “La 

variable a interpolar”> Output surface raster “Lugar donde se guardara el archivo generado, colocarle 

nombre que se desea que tenga”> Save> Environment Settings> Proccessing Extent “Seleccionar el 

shapefile de lotes evaluados”> Raster Analysis> Mask “Seleccionar el shapefile de polígonos de los 

lotes evaluados”> OK> OK. 
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  5.2.1.3. Estimación de TCH. Abrir el software ArcGIS 10.2> Add Data> seleccionar 

shapefile de lotes y puntos geo referenciados> Add> ArcToolbox> Data Management Tools> 

Features> Features To Line> Input Features “Seleccionar el shapefile de puntos”> OK. 

 ArcToolbox>Analysis Tools> Proximity> Buffer> Input Features “Seleccionar el shapefile de 

líneas que se trabajó anterior mente” > Output Features Class “Nombre y lugar donde se guardara el 

archivo”> Save> Distance> Linear unit “4.5”> Meters> OK.  

 Para obtener el shapefile de TCH se realiza un Joins: Click derecho sobre el Buffer 

generado>Joins and Relates> Join> Join data from another layer based on spatial location> Each 

polygon will be given a summary of the numeric attributes of the points that fall inside it, and a count 

field showing how many pints fall inside it> Seleccionar el lugar y asignación del nombre del archivo> 

Save> OK. 

 A la tabla de atributos generada se le agrega 2 columnas; Click derecho sobre el shapefile que será 

analizado> Open Attribute Table> Table Opcion> Add Field “nombre de la columna”> Type> Double> 

OK: Área; donde se calcula el área por medio del ArcGIS, Click derecho sobre la columna creada> 

Calculate Geometry> Unists> Meters> OK. 

Columna de TCH: Click derecho sobre la columna> Fild Calculator (Formula: (10000 * [PESO]/ 

[AREA])).> OK. 

Seguidamente se trabaja la interpolación IDW y Kriging utilizando la variable TCH para interpolar 

  5.2.1.4. Generación de interpolaciones para obtención de mapas de rendimiento 

en cosecha manual al momento del alce mecanizado.  

 Elaboración de polígonos: basado en los datos que se generó por cada una de las metodologías a 

evaluar se añadió una columna con el encabezado de “No JAULA”, donde a través del número de 

envió se inició colocando un correlativo de 1, 3, 4…… para cada una de las filas con datos que 

integraban el envió completo hasta llegar al correlativo 40 que equivale a igual número de jaulas. 
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 Seguidamente se preparó cada base de datos en el programa de Excel para ser cargada al programa 

de ArcGIS v10.2. , donde a través de la herramienta Add Data se cargó la tabla de Excel conteniendo 

los siguientes campos: Metodología, No_Jaula, apuntador, waypoints, coordenadas en formato UTM, 

No_uñadas y Peso_Toneladas. Estando la tabla cargada se procede a transformar los datos a una 

shapefiles utilizando este procedimiento: Clic derecho sobre la tabla>Display XY Data>X Field: 

selecciono X, Y Field: selecciono Y>Edit>Selec>Projected Coordinate Systems>WGS 1984 UTM 

Zone 15N.  

 Estando el shapefile de puntos generada se colocó sobre el shapefile del polígono del lote 3-16 de 

finca Carrizal, donde se colocaron puntos de referencia utilizando una herramienta para trazar los polígonos 

Editor>Star Editing>Distance-Disntace> Direction>Disntance, después se formaron los polígonos según la 

distribución de los puntos tomados con el navegador de GPS y agrupados por jaulada para poderlos 

identificar al momento de realizar los trazos de Norte a Sur simulando la dirección de los surcos, cada trazo 

se realizó con una separación de 9 m que es el ancho de 6 surcos de caña separados a 1.5 m y que al 

momento del alce son recolectados por una alzadora en una recolección o pasada. 

 Con la cuadrícula dibujada se procedió a asignarles el tamaño del polígono según los puntos que 

tuviera distribuidos cada jaulada, generándose un total de 40 polígonos que es el mismo números de 

jauladas recolectadas del lote evaluado, el procedimiento que se utilizó para cortar los polígonos fue: 

Editor>Star Editing>Cut Polygons Tool y para unir los polígonos fue: Editor>Star Editing>Merge. 

 Interpolaciones y edición de mapas: en el mismo programa de ArcGIS v10.2, se realizaron dos 

interpolaciones por metodología una utilizando la metodología de IDW y otra la metodología de Kriging, 

utilizando el siguiente procedimiento: 

Se cargaron en la ventana de ArcMap los shapefiles de los puntos, según la metodología que correspondiera 

y el polígono del lote evaluados. 

 Abrimos la herramienta ArcToolbox>Spatial Analyst Tools>Interpolation>seleccionamos la 

metodología a usar>IDW/Kriging>Input point feature (seleccionar shapefile de puntos)>Z value field 

(seleccionar la columna TCH)>Output Raster (nombre del raster)>Output cellsize  
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(0.5m)>Environments>Processing Extent>Extent (seleccionar el shapefile del polígono del lote)>Raster 

Analysis>Mask (seleccionar el shapefile del polígono del lote)>OK>OK. 

 Estando la interpolación generada procedemos a calibrar los rangos de TCH y los respectivos 

colores para poder ser observados en el Raster utilizando los siguientes pasos: Doble clic sobre el nombre 

del Raster>Classified>Classes(5 clases)>Classification>Break Values(90, 120, 150, 180 y mayor 

180)>Aceptar. 

 

Tabla 1: Categoría de colores de mapas de rendimiento 

Categoría TCH TCH 

Rojo Gris Blanco 

< 90 255 0 0 

90-120 230 152 0 

120-150 152 230 0 

150-180 151 223 255 

> 180 0 92 230 

Elaborado: Autor. 

 

Tabla 2: Categoría de TCH de los mapas de rendimiento 

 Categoría TCH COLOR 

< 90   

90-120   

120-150   

150-180   

> 180   

Elaboro: Autor 

 Después de tener todas las interpolaciones se generó dos mapas por cada metodología siendo un 

total de 6 mapas, exportados en formato JPG y PDF, utilizando la herramienta File del ArcGIS v10.2. 

Con la siguiente metodología File>Export Map>Nombre (según la metodología que correspondiera)>Tipo: 

(JEPG ó PNG)>Guardar. 

 Obtención de TCH y variables de respuesta por cada metodología con el método de interpolación 

de Kriging. 
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 En la ventana de ArcGIS v10.2. , se debe de cargar los shapefiles de polígono del lote en estudio y 

el Raster generado por la interpolación y se siguen los siguientes pasos:  

 Abrir la ventana de ArcToolbox>Spatial Analyst Tools>Zonal>Zonal Statistics as Table>en la 

venta de Input Raster or feature zone data (colocar el shapefile del polígono del lote)>Zone field (Colocar 

la columna que se analizara en este caso es la de TCH)>Input value Raster (Seleccionar el Raster de la 

metodología que corresponda)>Output table (colocar nombre y seleccionar ubicación de la tabla 

resultante)>OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

 

6. RESULTADOS. 

 

 Comparar la producción de caña de azúcar de las metodologías empleadas para realizar los mapas 

de rendimiento del cultivo: 

 El cuadro resultante de la obtención promedio de TCH por cada una de las metodologías es la 

siguiente: 

Tabla 3: Estimación de TCH de mapas de rendimiento 

DATOS GENERALES INTERPOLACIÓN TRES METODOLOGÍAS EVALUADAS 

Metodología  
No punto 

GPS 

Valor mínimo 

TCH 

Valor 

máximo 

TCH 

Media TCH 
Porcentaje de variabilidad 

del TCH respecto a báscula 

INICIO-

FINAL 
40 133.52 184.31 154.84 2.49 

PUNTO-

UÑADA 
1,917 61.32 305.6 157.67 4.41 

PUNTO-

CORTADOR 
495 

84.25 

 
271.85 157.9 4.56 

BÁSCULA  - - - 151  0 

Elaboro: Autor. 

 El valor menor  de la desviación estándar de la  metodología de 1 punto al inicio y 1 punto al final de donde 

se describe con el  valor del porcentaje de variabilidad que también es menor (2.29%) en TCH real, según loa análisis 

realizados. 

 

 Generación de  mapas de rendimiento con las tres metodologías  evaluadas utilizando sistemas de 

información geográfica:  
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Figura 3: Mapa de rendimiento de la  metodología de 1 punto por cada uñazo de alzadora

 

 Luego de la generación del mapa de rendimiento por medio del programa ArcGIS v 10.2.  Se logró 

establecer que los rendimientos en toneladas de caña por hectárea (TCH), en las distintas zonas del área del 

lote evaluado tienden a variar; por tal razón  los distintos bloques están clasificados  por colores en 

términos de rendimiento de caña, para que sea más fácil entender el proceso más apegado a la realidad en 

campo; en el mapa se puede visualizar que el lote tiende a tener una gran mayoría de área del color verde, 

así mismo hay algunos bloques en el lote, que tienden a mejorar por mucho su nivel de producción; de 

igual manera existen áreas que el rendimiento disminuye considerablemente como lo están los colores 

rojos, esto hace referencia que se obtuvo una respuesta significativa en la producción de (TCH), con esta  

información se puede analizar por qué se obtuvo esta  respuesta, con el motivo de poder implementar 

procesos agronómicos que conduzcan a ser más eficientes y homogéneos la producción de caña de azúcar  
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En (TCH). Observando cuales son las características de las zonas de color azul, celeste o verde, para 

homogeneizar el resto de las áreas con las áreas más productivas  poder incrementar la productividad del 

lote. 

Figura  4: Mapa de rendimiento de la metodología de 1 punto donde estuvo un cortador dentro de la chorra.

 

 Luego de la generación del mapa de rendimiento por medio del programa ArcGIS v 10.2.  Se logró 

establecer que los rendimientos en toneladas de caña por hectárea (TCH), con la metodología de 1 punto 

donde estuvo un cortador dentro de la chorra, tienden a variar en su rendimiento, con respecto a las otras 

metodologías, así mismo se generan distintos bloques dentro del lote que son clasificados  por medio de 

colores con respecto al rendimiento (TCH), esto se realiza para que sea más fácil entender el proceso más 

apegado a la realidad en campo; en el mapa se puede visualizar que el lote tiende a tener mayor área del 

color verde, de igual manera existen áreas que el rendimiento disminuye considerablemente como lo están  
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los colores rojos, esto hace referencia que se obtuvo una respuesta significativa en la producción de (TCH), 

con esta  información se puede analizar por qué obtuvo estas respuesta, con el motivo de poder 

implementar procesos agronómicos que conduzcan a ser más eficientes y homogéneos la producción de 

caña de azúcar en (TCH). A diferencia de la Figura 3, dicha figura genera un área visualmente menor 

detallada que la anterior, esto significa que la correlación se realiza con menor cantidad de datos, genera la 

misma información pero con un detalle a menor escala, de tal manera que los bloques de los colores son 

mucho mayores en medida de área, hablando visualmente. 

Figura 5: Mapa de rendimiento de la metodología de 1 punto al inicio y  1 punto al final de donde se llena la jaula.

 

  Luego de la generación del mapa de rendimiento por medio del programa ArcGIS v 10.2.  Se 

logró establecer que los rendimientos en toneladas de caña por hectárea (TCH), con la metodología de 1 

punto al inicio y  1 punto al final de donde se llena la jaula, tienden a variar en su rendimiento, con respecto 

a las  



 
 

25 

otras metodologías, con respecto a las otras metodologías esta tiende generar valores con menor 

consistencia en los distintos bloques generados dentro del lote con respecto al rendimiento (TCH),  de igual 

manera en el mapa se puede visualizar que el lote tiende a tener mayor área del color verde, así mismo hay 

ciertos bloque en el lote, que tienden a mejorar por mucho su nivel de producción, esto hace referencia que 

se obtuvo una respuesta significativa en la producción de (TCH), con esta  información se puede analizar 

por qué obtuvo estas respuestas, con el motivo de poder implementar procesos agronómicos que conduzcan 

a ser más eficientes y homogéneos la producción de caña de azúcar en (TCH). De manera visualmente se 

marca una diferencia muy marcada en cuanto al área ocupada por los bloque de colores y que están 

distribuidos de manera uniforme  los bloques dentro del lote evaluado, debido a que se utilizó una menor 

cantidad de datos para generar el mapa de rendimiento como se establece en la Tabla 3, pero esto incide a 

que genere menor detalle de cómo se comportó el rendimiento en todo el área del lote, dando como 

resultado valores visuales con menor detalle.   

 

 

 

 

 

 

 

 

 

 



 
 

7. ANÁLISIS DE RESULTADOS. 

 Se  muestran diversos bloques de colores con forme a la producción de toneladas de caña por 

hectárea (TCH) los cuales están clasificados en las siguientes escalas: 

Tabla 2: Categoría de TCH de los mapas de rendimiento 

 Categoría TCH COLOR 

< 90   

90-120   

120-150   

150-180   

> 180   
 En las Figuras 3 y 4 (ver  figuras 3 y 4)se observan bloques  con valores de (TCH) del rango de 

120-150 dentro del  lote muestreado, así mismo existen puntos críticos que generar lugares que deben 

analizarse con mayor profundidad, como lo son las áreas del color azul, que son valores que sobre pasan el 

promedio del lote, de igual manera los bloques de color rojo, que los valores que se expresan son muy por 

debajo del valor promedio del lote; con esto se pueden estudiar con mayor profundidad, esto se realiza con 

el fin de que el promedio del valor real del lote sea el más alto, mejorando de esta manera la producción por 

hectárea de la zona cañera.   Así mismo se puede observar la Figura 5 (ver figura 5) que muestra los 

bloques de colores con menor variación y demuestra un lote más homogéneo, con esto no demuestra mayor 

información del comportamiento de la variabilidad de producción de las zonas cañeras. 

 La variabilidad visual que se observan  los bloques de colores generados en los mapas de 

rendimiento, son producto de la cantidad de datos que se utilizó para la generación de los mismos, a mayor 

número de datos mayor es el detalle de los valores establecidos visualmente; esto se debe a que con más 

datos se pueden generar más valores de (TCH) en la misma cantidad de área. Así mismo se puede 

establecer el porcentaje de variabilidad del TCH que se generó en promedio del lote evaluado, con cada 

metodología que se utilizó, y según la Tabla 3, la metodología de 1 punto por cada acción de colecta de la 

alzadora (uñada) genera una variabilidad menor con respecto al (TCH real) establecido por báscula. Con 

base estadística la metodología que genera valores más apegados a la realidad de los campos de producción 

es la de 1 punto por cada acción de colecta de la alzadora (uñada).  
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 Luego del análisis mediante el programa ArcGIS v. 10.2  se ha logrado establecer que el 

porcentaje de variabilidad del rendimiento de las toneladas de caña por hectárea (TCH) que genero las 

distintas metodologías con respecto al (TCH) real dictaminado por la báscula del ingenio, fue menor por 

medio de la metodología de 1 punto al inicio y  1 punto al final de donde se llena la jaula, que fue igual al 

2.49%  mayor con respecto al (TCH) real del lote.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

8. CONCLUSIONES. 
 

1. Con base en la evaluación de la metodologías para generar  mapas de rendimiento de  producción, 

y de esta manera se establece la variabilidad productiva en los campos de producción (lote), esto 

permite analizar y ajustar  las decisiones, que se van a consolidar en  planes de manejo 

agronómico tal es el caso de la nutrición, la ubicación varietal, el manejo del riego y el drenaje, el 

diseño de campo, el manejo de plagas y enfermedades. Con esta correlación de la producción bajo 

las diferentes condiciones puede tener mayor o menor impacto dependiendo de los manejos que se 

le da a la relación: suelo-planta-agua, por eso es que  los mapas de rendimiento son una 

herramienta que sirve  para complementar e interpretar los rendimientos de producción de un área 

determinada con mayor detalle. 

2. Con la evaluación de las tres distintas metodologías se logró establecer los mapas de rendimiento 

de cada una de ellos. (ver figuras: 3, 4 y 5).   

 

3. Le generación de los mapas de rendimiento observados en las figuras: 3, 4 y 5 establecen, la 

variabilidad visualmente que se tienen en los bloques de colores generados en los mapas de 

rendimiento esto se puede establecer debido a que las metodologías, generar una distinta 

separación de punto en la ecuación lineal generada por la nube de datos; esto establece que los valores 

generados por cada uno de las metodologías evaluadas demuestra una caracterización con distinto grado de 

detalle de la variabilidad en los campos de producción.  

4. La metodología más efectiva para realizar mapas  de rendimiento en caña de azúcar en el sistema 

de cosecha manual y alce mecanizado. 

 Metodología de 1 punto donde estuvo un cortador dentro de la chorra: debido a la facilidad que se 

tiene para que el apuntador de la handheld que puede realizar la acción de toma de puntos geo-

referenciados en el momento que está realizando la toma de datos de los cortadores que están en chorra que 

es siendo tomada por la alzadora y depositada en una misma jaula, debido a la consistencia que se tienen en 

la toma de datos. 
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 Después estos son utilizados para la elaboración de los mapas  de rendimiento, ya que estos 

muestran una respuesta visual en el mapa de rendimiento de mayor consistencia en la tendencia de nivel de 

producción de toneladas de caña por hectárea (TCH) dentro del lote que está siendo evaluado, 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

9. RECOMENDACIONES. 

 
1. Realizar evaluaciones de la metodología 1 punto donde estuvo un cortador dentro de la chorra en 

el proceso de cosecha de caña de azúcar, por ser la forma más práctica para la toma de datos del 

GPS al momento del alce, mediante el apuntador, para evitar ocupar una persona extra para el 

frente de alce.  

2. Realizar análisis de costos con la metodología de 1 punto donde estuvo un cortador dentro de la 

chorra, con el fin de determinar la factibilidad económica de la generación de los mapas de 

rendimiento.  

3. Realizar los análisis estadísticos pertinentes, con el fin de fundamentar la separación de los puntos 

generados por la nube de datos. 

4. Generar  mapas en otras zonas y realizar análisis de las áreas con menor producción de TCH y 

también las que cuentan con mayor producción de TCH, con el fin de determinar  porqué de la 

variación que se obtiene en la producción; para poder correlacionar los análisis con información 

climática, mapas de suelos, prácticas agronómicas, etc.  

5. Replicar este tipo de evaluaciones para la elaboración de mapas de rendimiento al momento del 

alce mecanizado, en consenso con el área de cosecha, para que ellos estén involucrados en la 

investigación, de tal manera que puedan dar su apoyo, en el frente de cosecha, para que al 

momento del alce mecanizado en corte manual, no cambie la forma de realizar el alce, así 

también, que no se cambie de lote al momento de la evaluación; para no alterar los datos. 

6. Establecer un grupo de investigación que esté capacitado; para el uso y manejo del Sistema de 

Posicionamiento Global (GPS por sus siglas en inglés), para poder realizar la toma de datos geo 

referenciados, de una manera confiable y precisa. 
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11. ANEXOS. 

Anexo 1: Registro de toma de waypoint. 

 

Elaboro: Autor 
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Localización:

Finca

Lote

Fecha

Encargado

Período de zafra:

Ciclo de cultivo:

Variable:

Unidad de medida:

Punto-uñada Punto-cortador Punto inicio y final Número de envio

Rendimiento (TCH)

Fincas ingenio La Unión

2015/2016

NO APLICA

Metodologías de mapas de rendimento

El Carrizal

316

16-dic-15

Observaciones

Evaluación de tres metodologías para generar mapas de rendimiento en cosecha manual al momento del alce 

mecanizado en el cultivo de la caña de azúcar



 
 

12. GLOSARIO. 

 
1. GPS (Global Positioning System) por sus siglas en inglés, que significa sistema de 

posicionamiento global. es un sistema de navegación basado en satélites y está integrado por 24 

satélites puestos en órbita por el Departamento de defensa de los Estados Unidos. 

2. Chorra: Es el conjunto de 6 surcos del cultivo de la caña de azúcar con una distancia no mayor a 

20 metros, que se cortan y se apilan en una fila, para ser cosechado mediante la alzadora. 

3. Shapefile: es un formato de archivo informático. Es un formato vectorial de almacenamiento 

digital donde se guarda la localización de los elementos geográficos y los atributos asociados a 

ellos. 

4. Uñazo: Acción de la cosechadora para recolección de caña cortada a granel, para luego ser 

depositada en las jaulas de transportes, para ser enviadas al ingenio. 

5. Jaula: Denominada también carreta, que se utiliza para transportar la caña cosechada de campo 

hacia el ingenio. 

6. SIG: Es un sistema de información geográfica, es una integración organizada de hardware, 

software y datos geográficos diseñada para capturar, almacenar , manipular, analizar y desplegar 

en todas sus formas la información geográficamente referenciada. El sistema permite separar la 

información en diferentes capas temáticas y as almacena independientemente, permitiendo trabajar 

con ellas de manera rápida y sencilla.  
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